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Paula Radetzky is on a mission to save the world from losing pieces 
of its history, one language at a time.

According to Radetzky, an assistant professor at the University of 
Oregon’s Department of East Asian Languages and Literatures, since 
2001, many 
of the world’s 
l a n g u a g e s 
have been 
r a p i d l y 
disappearing.

“ T h e r e 
are many 
languages that 
are considered 
e nd a n ge r e d , 
one is dying 
every week,” 
R a d e t z k y 
said. “If you’re 
conservative, 
then one is 
dying every 
two weeks.”

J u s t 
like animals 
and plants, 
l a n g u a g e s 
can become extinct when they are no longer spoken or taught and their 
last speakers die. According to Radetzky, this happens for a number of 
reasons, but the most dominant factors are social and economic changes 
that force entire groups to adopt other cultures’ customs and tongues.

In 2000, Radetzky began working with two indigenous tribes in 
Taiwan: the Saaroa and the Kavalan. Since then she has spent several 
months every summer living and talking with native speakers, as well 
as documenting their words, stories and history.

The Saaroa tribe lived in isolation for centuries in the south-central 
mountains of Taiwan. About 60 years ago, the Saaroa began to mingle 
and intermarry with a larger tribe, ultimately adopting its language. 

After World War II, the Chinese government made indigenous 
children attend state-run schools where they learned Mandarin Chinese. 

Saving the World One Language at a Time
UO Professor Fights to Conserve Dying Languages

Josh Alder, Staff Reporter

Paula Radetzky and her Saaroan informant Kilakilau  
Tumamadikisase on a porch in Tawain during Radetzky’s 

field work in the summer of 2004. There are about 5  
native speakers of Saaroa left.
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Radetzky Works to Conserve World’s Languages
Continued from page 1

The Saaroa tribe’s numbers have since dwindled 
to about 300, and today, there are only about 5 
remaining speakers of Saaroa.

In contrast, the Kavalan tribe, based on Taiwan’s 
east coast, has about 600 members with about 50 
native speakers.

Radetzky grew up in Tokyo where she attended 
international schools and became fluent in both 
English and Japanese. Later, she became fluent in 
French, Spanish, and Korean. However, she doesn’t 
speak fluent Mandarin. Luckily, Taiwan’s political 
history has provided her an accessible means of 
communication.

   “Between 1895 and 1945, Taiwan was 
governed by Japan, and [the Saaroa] did have some 
village schools, so some of the people went to school 
for about four years and they learned Japanese,” 
Radetzky said. “I speak to them in Japanese, and 
that’s how I work with them.”

When Radetzky attended Columbia University 
in New York City, she got a bachelor’s degree in 
French because the school didn’t have a linguistics 
program. However, she was later able to study 
linguistics as a graduate student at the University of 
California-Berkeley, earning a Ph.D. in 2002.

It was at UC-Berkeley that she became interested 
in the Austronesian language family, the largest 
language family in the world with more than 1200 
languages. By contrast, the Indo-European family, 
which includes English, Russian, Spanish, Hindi, 
Greek, Welsh, Farsi, and more, has approximately 
440 languages. The Austronesian family is made 
up of languages widely dispersed throughout the 
islands of Southeast Asia and the Pacific, including 
Hawaiian, Tagalog, Javanese, Malay, Rapa Nui (the 
language of Easter Island), Fijian, Samoan, Maori 
and Malagasy.

  “Growing up in a foreign country is always 
good for your language awareness,” Radetzky said. 
“My father was a French and Spanish teacher, my 
mother was a French and English teacher.” 

It was Radetzky’s grandfather who first told 
her of the native peoples of Taiwan. He had visited 
Taiwan in the 1930’s and told her about the indigenous 
people who lived there. 

Even today the Saaroa people are still not 
recognized by the government as a tribe. “They are 
called “Tsou” (pronounced “tso”), and are grouped 
together with two other tribes,” Radetzky said. “The 

Tsou language is the biggest of the three, so that’s 
what they’re called.”

The Kavalan tribe, on the other hand, received 
tribal status two years ago after years of pleading 
with the Taiwanese government.

Radetzky’s overall goal is to make sure the 
Saaroa and Kavalan languages don’t become lost to 
history like so many other languages.

“[I want] to document the language since it’s 
going to be gone in less than 5 years,” Radetzky 
said. “There are five speakers; they’re all elderly and 
losing their memories or their health.”

While it is difficult to pin down the reasons why 
some languages become endangered, some people 
blame the government for failing to encourage the 
tribe to keep their cultures and customs intact. 
However, the problem is often a matter of societal 
preferences and economics.

“Some governments are definitely guilty of 
forcing people to learn the dominant language,” 
Radetzky said.  “But even if that isn’t the case, there 
are so many economic forces at work. People want to 
go to the city… to make money and for educational 
opportunities for their children. They’re no 
longer living in the village and keeping any of the 
traditions.”

According to Radetzky, it’s a pattern that is all 
too common around the world. “Once you realize 
that a language is going to be gone, it’s almost too 
late, unless there is some kind of huge turnaround,” 
she said.

Radetzky plans on publishing her findings at 
some point in the next few years, but the task is 
expensive and time consuming. To help finance the 
project, she has applied for numerous grants, and has 
received more than $70,000 over the past five years, 
including a $40,00 joint grant from the National 
Science Foundation, the National Endowment for 
the Humanities as well as the Smithsonian, which 
was awarded to her in March 2005.

But, Radetzky’s research is not spurred by any 
acclaim or financial support she might receive in 
the future; rather, it is a labor of love fueled by a 
deeply founded passion to keep these tribes from 
losing links to their past. 

“I think it’s just an important thing to document 
languages because that’s the only record you’re 
going to have after the culture vanishes. It’s their 
heritage.”
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YLC continues to be a campus pioneer in the 
area of web-based speech, and with the imminent 
release of our latest tool, Amiga Live Chat, faculty 
and students will have access to a real-time au-
dio/video communication tool that runs inside of 
Blackboard.

Like other chat software, Amiga Live Chat al-
lows users to communicate via text, audio, and 
video. However, having been designed with an 
academic audience in mind, Amiga Live Chat is 
unique in several ways. Because it runs from with-
in Blackboard, the university’s learning manage-
ment system, faculty will find it easy to access and 
configure for their respective needs. 

Likewise, students will be using a tool that 
is ad-free and is optimized for one-on-one discus-
sion, tutoring, and problem-solving. Perhaps most 
significantly, because it uses off-the-shelf software 
and hardware (Flash Player and USB-microphones 
or webcams), both faculty and students probably 
already have access to everything they need to get 
started. Essentially, you log in, you enter a discus-
sion room, and you begin speaking (or typing). 
Besides YLC, other computer labs around campus 
will have the appropriate equipment.

Designed to be the synchronous counterpart 
to the YLC Message Board, the multimedia discus-

sion tool we released last year, Amiga Live Chat 
facilitates the kinds of discussions or virtual office 
hours where feedback is needed right away. While 
the software won’t do much to free up busy sched-
ules, it will allow conversations to continue well 
beyond the classroom. Beta testers report that it is 
very easy to use and greatly appreciate the extra 
value hearing and/or seeing your discussant adds. 

In foreign languages we’re excited about hav-
ing a tool that will pair up speakers across the 
ocean as easily as across campus. Our standalone 
version, which is multilingual, will contain speech 
prompts, suggestions for doing self-study language 
learning, and a feedback tool that lets users get 
more information on their interlocutors, like how 
other chatters have rated him/her.

Amiga Live Chat is in beta testing right now. 
We anticipate that several classes will use it during 
the Fall and that it will be widely available Winter 
term. Instructors interested in using it or getting a 
demonstration should contact Jeff Magoto at YLC or 
check out:

http://babel.uoregon.edu/amiga
Amiga Live Chat is generously funded by 

the Northwest Academic Computing Consortium 
(NWACC) and the UO’s Educational Technology 
Fund.

New Web-Based Speech Application

Amiga Live Chat allows real time messaging as well as audio or video 
chat (top left). Students should be familiar with the layout of  

Amiga since it works similarly to a chatroom (top right).  
Instructors can set their room up to suit their own needs, organized  
by topic, textbook chapter, language or anything else. Students can 
evaluate the session as well as their interlocutor (bottom right) to  
help future students choose a partner. Amiga is Flash-based and  

Unicode compliant, which means that it can handle virtually any lan-
guage including Chinese, Japanese, Hebrew, Arabic and Russian.



Last March I set out for the 
end of the world. 

As a Political Science stu-
dent in my next-to-last quarter at 
the U of O, I wanted to take ad-
vantage of my time left to accom-
plish one of my yet uncompleted 
undergraduate goals—to achieve 
fluency in Spanish. 

I left Oregon to spend a term 
studying abroad in Chile, a na-
tion that refers to itself endear-
ingly as ‘el fin del mundo,’ or ‘the 
end of the world’. With territory 
extending for over 2,700 miles 
and boasting possession of the 
most remote island on earth, 
Easter Island, Chile does seem to 
warrant the title.

This narrow nation, just 
over 100 miles wide, takes great 
pride in the diversity of its natu-
ral beauty. The driest desert in 
the world, the Atacama, occupies 
northern Chile. A journey south 
takes one through the noisy hub-
bub of the Santiago metro area, 
past the sleeping giants of the 
Patagonia range and through the 
picturesque Lake District, which 
looks remarkably like western 
Oregon. 

Finally the nation plunges 
south through the massive gla-
ciers of Torres del Paine to Cape 
Horn where the country’s terri-
tory finally comes to rest a mere 
600 miles from Antarctica.
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A View from the End of the World
By: Ariel Olson, Contributing Editor 

as I walked through town on my 
way to campus. Still, my great-
est lessons and those that I have 
brought home with me weren’t 
about Chile, but rather about 
the U.S., and how our nation 
and culture are perceived from 
abroad.

Within my first week in 
Chile I was forced to confront 
an expectation that I didn’t even 
realize I had until it wasn’t met. 
Being an international student, I 
expected that more people would 
be interested in me. 

To me, the diversity of the 
United States is one of its greatest 
attributes and I consider myself 
lucky to have the opportunity 
to interact with people from all 
over the world and to share in 
their knowledge and experiences.

For this reason, I was sur-
prised when I arrived in Chile 
and found that, at least initially, 
few people had much interest in 
me or my country, and even few-
er had the patience to talk with 
me during the first three weeks 
or so when I still had difficulty 
expressing myself in Spanish. 

I had to be patient, both 
with myself and with what I 
perceived to be a general lack of 
interest in us as North American 
students. Doing so meant re-
membering that U.S. culture is 
constantly being exported all 

I had been abroad before, 
but never for such an extended 
period of time. I was prepared to 
learn, but I expected most of my 
discoveries to be about Chile and 
the cultures of South America. I 
never imagined that after three 
and a half months in Chile, I 
would learn so much about being 
from the United States. 

That’s not to say that I didn’t 
experience Chilean culture fully. 
I quickly became accustomed 
to greeting with a kiss on the 
cheek, to eating huge lunches 
and a light “once” for dinner, to 
adding “po” to the end of my sen-
tences just for good measure and 
to witnessing frequent protests 

U.S. study abroad students enjoy 
a stroll through El Museo del Cielo 

in Valparaiso, Chile.



over the world. While I was in 
Chile, headlines from home were 
consistently shown on the news. 
Our music, movies and television 
programs ran relentlessly over 
Chilean broadcasting stations. 
Even our taste in food and fash-
ion had noticeably influenced 
their menus and clothing styles, 
though always with a Chilean 
flare. 

With so much forced ex-
posure to the U.S., how could I 
blame my Chilean friends for not 
expressing much further interest 
in my culture?

On several occasions indi-
viduals attempted to raise issue 
with me regarding recent U.S. 
foreign policy and were sin-
cerely shocked to discover that 
my views differed in many ways 
from what they saw on TV.

Others were surprised by 
my physical appearance and 
personality. “I expected you to 
be taller, whiter, fatter, louder, 
lazier, wealthier, more blonde, 

more selfish, etc…,” they would 
tell me. 

Many people I met assumed 
that I, like other U.S. exchange 
students before me, chose to go 
abroad in order to party and 
sightsee. 

At first I was frustrated by 
these generalizations, but the 
more I thought about them the 
more I realized they weren’t 
meant to offend. Instead they 
stemmed from a genuine misun-
derstanding or lack of exposure 
to the real diversity of our soci-
ety.

Unfortunately, the ways 
in which I differed from the 
Chilean conception of the U.S. 
didn’t immediately serve to 
change these views; my friends 
simply considered me to be less 
North American, and the stereo-
types persisted.

Changing these negative per-
spectives about the United States 
required months of dialogue, lots 
of patience and a genuine shift in 

my own conceptions of my home 
country.

It’s great to go abroad. It’s 
fun to learn a new language, to 
experience a new culture and to 
travel to new places. But exercis-
ing these privileges implies some 
degree of responsibility. 

Throughout my time in 
Chile  I was constantly observed, 
evaluated and questioned. I had 
to work hard to earn the trust of 
those I met and to demonstrate 
that I wasn’t just in the country 
for some sort of extended vaca-
tion, but that being there meant 
more to me. I was more than a 
student—I was a diplomat.

The United States is in the 
hotseat and the world is watch-
ing. Even in Chile, at the end 
of the world, people are wait-
ing for us to break the mold and 
exemplify a new kind of North 
American;  one with a genuine 
interest in and commitment to 
the rest of the world. 
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Foreign Language 
and International 
Studies Day 2005

If you could choose the best trip around 
the world, what would it be? What coun-
tries would you see? What cultures would 
you visit? What languages would you try to 
speak?

FLIS 2005 was just such an opportu-
nity. It was a day to travel around the world: 
to drink Japanese tea, travel through roman-
tic France, hear about German history, dis-
cover the languages in Ethiopia and dance 
to  African-Brazilian songs. These were only 
a few of the activities that took place at last 
May’s Foreign Language and International 
Studies Day. 

Twelve hundred high school students 
from all over Oregon packed the University 
of Oregon campus for the 27th year in a row 
to attend over 110 different cultural presen-
tations. 

 
“We get to see all these different cul-

tures. It’s pretty educational,” said Michael 
Demick from Lincoln City, who watched a 
presentation on Spanish culture. 

Some students preferred the language 
lessons, while others were more into the 
cultural presentations. Some did everything 
they could to taste lots of different inter-



Foreign Language 
and International 
Studies Day 2005

national foods; others preferred to dance it 
all out in the music-related sections. One 
thing is for sure: it was a day for all kinds of 
tastes, and a chance for everyone to explore 
their interests in many different parts of the 
globe.

There were over 25 languages fea-
tured–from the most common ones, to a few 
hardly anyone had heard of. An American 
Sign Language presentation captivated its 
audience—the dexterity required to sign ef-
fectively seemed so hard.

The Portland-based theater group 
Teatro Milagro enriched FLIS this year by 
telling a story about immigrants from the 
other side of the border. Cuéntame Coyote 
was a tale about the ideas and adventures of 
two orphan girls in Mexico trying to cross 
the border to the United States. It eloquently 
captured the hopes and frustrations of a 
world thirsty for more cross-cultural com-
munication.

Once again, FLIS was a day for explor-
ing new places, trying to understand cul-
tures other than our own, and appreciating 
the many ways that language makes the 
world go round.  

by Leticia Camargo, Staff Reporter



Typing in another language
1. First add your desired 

language to the available lan-
guages on the language bar. To do 
this, go to the Settings>Control 
Panel>Regional and Language 
Options>Languages (names 
will vary slightly depending on 
Windows version). Click on the 
“Details” button. It’s convenient 
to assign a shortcut key to switch 
between keyboards. Do this by 
activating the “Language Bar” or 
by assigning a key combination 
with “Key Settings…” 

2. Now to switch the key-
board to your desired language 
simply click on the language bar 
and select the language, or use 
the shortcut key you defined un-
der “Key Settings” – no need to 
worry about fonts. Switch back to 
English when done.

Accented characters
In typing a language that 

uses a Latin-based alphabet, but 
with accents (French, Spanish, 
German, Italian, etc…) there are 
three options. 

1. The first is to follow the 
above instructions to add the req-
uisite keyboard layout. Accented 
characters will then be much 
more accessible. 

Note, however, that this will 
require learning a different key-
board layout (some are more dif-
ferent from the English QWERTY 

keyboard than others).
2. The second is to use the 

character map. Under Programs>
Accessories>System Tools is the 
Character map program. Open 
this program and you will see 
a large chart with virtually any 
accented letter and symbol you 
could need. To insert one into 
your document “select” the let-
ter you need and either “copy” it 
to the clipboard and paste it into 
your document (ctrl-v), or find 
the keystroke in the lower right-
hand corner (it will be alt plus 
a four-digit number beginning 
with 0). If you use these letters 
often it is worth learning the key-
stroke.

3. In Microsoft Word you 
can insert a special character by 
going to Insert>Symbol. Select 
the letter you need and click 

Word Processing in a foreign language: PC
“Insert” and it will be inserted 
wherever the cursor is. 

Email
1. Switch the keyboard to 

your desired language, if neces-
sary, before typing your mes-
sage. If you are typing in a non-
Latin-based alphabet (Russian, 
Chinese, Arabic, Hebrew) and are 
using a web-based email program 
(Hotmail, Yahoo), switch the 
Character Coding (under View) to 
one of the Cyrillic options. 

2. When viewing emails 
using a different script, change 
the Character Set (under View or 
Format) to the appropriate choice 
(it may take a few tries to pick 
the right one). Again, if the mes-
sage is entirely question marks, it 
is most likely undecipherable. 
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Sending and receiving email in a foreign language 
can be daunting, but it doesn’t need to be. The most 
important thing is to make sure you have the cor-
rect “character set.” All major web browsers (top) 

and email programs (left) have settings for charac-
ter set: just make sure to select the appropriate one 
before writing or reading your email. many of the 

newer programs will do this automatically.
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Setting up the keyboard
1. Go to “System 

Preferences” and under 
“International” select “Input 
Menu” and then click the box 
next to the language you need.

2. Now there will be an 
American Flag  at the top of the 
screen. To switch to an alternate 
keyboard, first click and hold 
on the flag and drag down to the 
language you need. Your key-
board should now speak another 
language! Note: Some languages, 
like Russian, will require partic-
ular fonts. Russian, for instance 
requires fonts with “CY” after it.

Email
1. When composing email in 

another tongue using one of the 
popular email programs (Eudora, 
OS X Mail or Entourage) you will 
follow the same steps as above 

Word Processing in a foreign language: MAC 
(switch input language by click-
and-dragging on the flag). When 
composing in a web-based email 
program (hotmail, yahoo) with a 
non-Latin-based language, make 
sure to go to View>Character/
Text Encoding and switch to an 
appropriate encoding before typ-
ing and sending your message.

2. If you receive an email 
that is unreadable, your first step 

is to either switch the character 
encoding as described above 
(if you are in a web browser) or 
to change the corresponding 
setting in your email program 
(Format>Character Set in 
Entourage).

3. Note that if the message 
is a string of question marks, it 
will most likely be unreadable no 
matter what you do with it.

AlphaMail
Tired of problems send-

ing or receiving email using 
non-Latin fonts with UO’s Web 
Mail? Well, this fall the uni-
versity is offering an alterna-
tive to your old (green) email, 
IMHO. AlphaMail, which is 
100% Unicode compliant, will 
be able to handle foreign lan-
guages much more easily. 

This means that it will 
be able to handle all your 
foreign-language correspon-
dance needs, whether they 
be in Polish, Thai, Pushto or 
Gujarati. If you can type a 
word-processing document 
in the language, you can now 
email in that language as well.

This new mail client can 
be accessed at:

alphamail.uoregon.edu.



The cross discipline contact 
was certainly a highlight of the 
week. As one participant noted: 
“I am particularly happy for hav-
ing found out what other people 
do, finding commonalities and 
establishing some links that will 
certainly end up in collaboration 
across disciplines and depart-
ments.”

elf-Study
Language 
Program

Linguistics 199

More Information at:

http://babel.uoregon.edu

Arabic
Farsi
Greek
Hindi/Urdu
Portuguese
Navajo
Indonesian

Fall  Offerings:

Availability subject to enrollment. There is a $50 instruc-
tional fee for UO students and a $100 fee for community 

members. For more information please visit:  
http://babel.uoregon.edu. 

Swahili
Thai
Romanian
Turkish
Vietnamese
Wolof
Bamana

Summer got off to a bang 
at YLC with the 2nd Annual 
Academic Affairs IT Workshop, 
which was held from June 13-
17. Thirty faculty from around 
campus spent the first week of 
their summer vacations explor-
ing multimedia software, editing 
video projects, making websites 

more interactive, and tweaking 
Powerpoint presentations.

Bringing such a diverse 
group of scholars together was 
an interesting logistical and cur-
riculum challenge for YLC staff. 
Multimedia is a vast area and at 
times we struggled to tailor our 
tutorials to some of our partici-
pants’ very discipline-specific 
needs. Fortunately, the partici-
pants were indulgent of our orga-
nizational lapses, and YLC Staff 
are quick learners, so each day 
we got a little better at meeting 
everyone’s needs. 

Guest lecturers helped an-
chor various IT strategies and 
methods in sound pedagogy. 
Examples ranged from the proj-
ect-based learning that is used 
in documentary filmmaking and 
multimedia authoring to innova-
tions in computer-mediated com-
munication which allow dispa-
rate groups to work and learn as 
if they’re in close proximity.

Media Workshop Gets Summer off to Bang
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This year’s Multimedia Workshop 
featured our biggest group ever:  
30 people! Participants learned  

the rudiments of web and document  
design as well as editing audio,  

video and photos, and basic  
Flash programming.

Experiential learning with 
technology. Here Joey Bargsten, 

AAA, demontrates his  
innovative lecturing style.



University of Oregon 1st-
year student Svetlana Easton was 
recently awarded a Bronze Medal 
in the 6th Annual National 
Russian Essay Contest sponsored 
by the American Council of 
Teachers of Russian (ACTR). 

Sveta placed third in Level 
1 of the Heritage Learner cat-
egory, meaning that her essay 
was judged against other native 
speakers with less than five years 
of formal schooling in Russia or 
the former Soviet Union. 

“All of us in REESC are ex-
tremely proud of Sveta’s achieve-
ment,” says Josh Overcast, REESC 
GTF and UO contest coordinator. 
“Aside from the obvious distinc-
tion of placing highly in a na-
tional contest with over dozens 
of other participants, Sveta is 

also the first participant from our 
university to receive an award. I 
should also note that Sveta was 
only one of two award recipients 
in all of Oregon. This really is 
something I hope Sveta feels she 
can brag about!” 

First held in 2000, the ACTR 
Russian Essay Contest continues 
to draw increasing numbers of 
college and university students 
from around the United States 
each year. The total number of 
participants and participating 
institutions has nearly doubled 
since 2003. 

“In 2004 we had one partici-
pant, and this year we had five,” 
notes Overcast. “I look forward 
to 10 or more of our Russian 
students submitting essays--and 
winning awards--next year!”

Student Wins Russian Essay Award

Everyday Etymology
Continued from page 12
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Brazil wood when they first navi-
gated the land’s coast. 

As we can see, association 
is one of the most common ways 
of naming objects or places, but 
language may also bring some 
ironies that we are just not aware 
of. The Spanish saying Ojalá, and 
the Portuguese Oxalá means “I 
hope that...” However, the term 
itself is originated from the older 
Arabic phrase “In Sh Allah,” 
which means “May Allah grant.” 

How ironic that these tra-
ditionally Catholic cultures, 
after hundreds of years battling 
the Islamic Moors to control the 
Iberian Peninsula, still use this 
traditional Islamic phrase. 

Language in close contact 
constantly influence one another. 
Confusions like that wouldn’t 

happen if people were more 
aware of the background of the 
words before they adopted them! 

Etymology influences our 
lives more than we think. It 
might even appear in your daily 
activities. Today when we hear 
the word alarm, we might associ-
ate it with some kind of warning, 
or perhaps with an alarm clock, 
the little object that emits a loud 
annoying noise that disturbs our 
cozy slumber and wakes us up 
every morning. Originally, how-
ever, to warn of approaching en-
emies, the French military used 
the Old Italian call, “all’arme,” 
which meant, “to arms!” And 
thus we get “alarm.” 

So tomorrow morning when 
you hear your alarm going off, get 
ready to battle another day! 

Svetlana Easton received a  
“Bronze Mdal” in the ACTR  

Russian Essay Contest

YLC welcomes six new 
GTFs this year. Each specializes 
in language teaching and/or 
technology, and will be working 
in conjunction with the Self-
Study Language Program.

Maria Benédita Santos, 
Brazil, Coordinator of the Self-
Study Language Program.

Sermsap Vorapanya, 
Thailand, Thai tutor and Research 
Assistant.

Marko Mwipopo, Tanzania, 
Swahili tutor and African Studies 
Program GTF.

Dorsaf Naoui, Tunisia, Arabic 
tutor and Fulbright Language 
Teaching Assistant.

Nilay Sevinc, Turkey, Turkish 
tutor and Fulbright Language 
Teaching Assistant.

Andrew Porter, USA, 
Multimedia specialist and 
Materials Coordinator.

YLC welcomes six new 
GTFs this year. Each specializes 
in language teaching and/or 
technology, and will be working 
in conjunction with the Self-
Study Language Program.

• Maria Benédita Santos, 
Brazil, Coordinator of the Self-
Study Language Program.

• Sermsap Vorapanya, 
Thailand, Thai tutor and 
Research Assistant.

• Marko Mwipopo, 
Tanzania, Swahili tutor and 
African Studies Program GTF.

• Dorsaf Naoui, Tunisia, 
Arabic tutor and Fulbright 
Language Teaching Assistant.

• Nilay Sevinc, Turkey, 
Turkish tutor and Fulbright 
Language Teaching Assistant.

• Andrew Porter, USA, 
Multimedia specialist and 
Materials Coordinator.
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Only Words …. ?
How Far Can Your Vocabulary 

Take You?
“Ojalá” I Knew What I Was 

Talking About!
A Simple “Ciao,” a History 

Lesson 
Words and Meanings You Don’t 

Learn in School

Musings on Language and Culture
Start Your Day with a Trip Back in Linguistic History

by Leticia Camargo, Staff Reporter

Ask any student if they think school is a place 
to have fun, and you will probably get that “what 
are you talking about?” look. But when the word 
originated in ancient Greece, it meant exactly that, 
a place for leisure.   

Originally, a school (or schole in Greek) re-
ferred to a time away from hard work outside under 
the hot sun. It was a chance for Greeks to rest and 
meet each other to discuss ideas. 
They believed that knowledge 
was very important, and that a 
man’s education would never re-
ally be complete. Thanks to their 
excitement for knowledge, most 
of our civilization’s structure 
comes from ancient Greece.

Just as earlier societies in-
fluenced our life style, they also 
made their mark on how we 
speak today. The development of 
languages can be very curious 
sometimes. Geography, weather, historical events, 
are a few of the elements that shape a culture, and 
therefore, a language, through time. Studying the 
word’s history, or etymology, can make us under-
stand a bit more about what we are trying to ex-
press.

Have you ever thought about how simple 
things that we say all the time arose? Daily greet-
ings in some languages might connect you not only 
with the person in front of you, but also with the 
cultures behind those words.  Languages such as 
Italian and Hebrew use the same word for both 

hello and good-bye. The Italian ciao, which has 
been adopted into so many languages, originated in 
shiavo, which meant a slave. Therefore, the mean-
ing of the expression used to be “I am [your] slave,” 
as a form of polite deferment. Nowadays, people 
all around the world use the expression with a 
smile on their face.  Israelis on the other hand wish 
Shalom, or peace, for people who are coming or go-

ing. 
From complex backgrounds 

to practical ideas, words can 
play a very helpful role in 
our daily lives. Have you ever 
thought about how many times a 
week you wonder which months 
have 30, and which 31 days? 
In some cultures, people count 
their knuckles trying to figure 
that out, but in Thailand that’s 
not necessary. They found a 
faster solution using vocabulary. 

Months with 30 days end with -on (like September 
Kanyayon), while months with 31 end with -om (as 
January, Magarakom), and February ends with -an: 
Kumpapan.

From simple to important names, words may 
express a little piece of a country’s history. For ex-
ample, “Argentina” came from a treasure that the 
Spanish people were looking for in the area during 
colonization: Argenta in Latin, or simply valuable 
silver. 

Along the same lines, Brazil came from the 
fact that the Portuguese found a great amount of 


